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This document describes various techniques for applying 
edits globally to multiple objects in your design. It covers 
using the Find Similar Objects dialog and Inspector panel 
combination, as well as the Parameter Manager and the 
Model Manager. Finally, it introduces queries and the List 
panel, a powerful technique for finding and editing design 
objects. 

 

Electronic design is the process of capturing a logical design in the schematic, then representing that 
design as a set of objects in the PCB workspace. Even for a small circuit, the schematic can include 
many components, each with numerous models and parameters, and the PCB workspace will end up 
containing a large number of design objects that make up the board. During the course of the design 
process, the properties of these objects will need to be changed as the designer works to balance out 
the various design requirements. 

To support the task of editing many objects, previous versions of Altium design tools included a feature 
called Global Editing. The basic approach of this feature was to edit one object, and then push those 
changes onto other objects.  

With the introduction of the DXP platform, the technique for applying an edit globally changed. The 
basic approach now is to select the objects to be edited, inspect their properties, and then edit them. 

Keeping this select – inspect – edit sequence in mind, let’s look at each step in detail. 

Selecting multiple objects 
There are actually a number of ways of selecting objects, for example 
the Windows standard mouse click shortcuts can be used. This 
approach is ideal when the number of objects to be selected is small, 
or perhaps when there are different kinds of objects to be edited 
simultaneously. 

 
Figure 1. Right click and choose 
Find Similar Objects 

To select many objects, including over a number of schematic sheets, 
you use the Find Similar Objects dialog. To open this dialog, right-click 
on one of the objects to be edited, and select Find Similar Objects 
from the context menu.  

Let’s walk through the process using an example. Let’s say we need to 
change the name of a power net in the schematic from VCC to 3V3. 
This requires all the VCC power ports on all of the sheets to have their 
Net attribute changed. The first step is to find a VCC power port on the 
schematic, right click on it, and select Find Similar Objects.
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Figure 1 shows the Find Similar 
Objects dialog after right-clicking on 
a schematic Power Port. It is 
important to note that the dialog 
lists the properties of the object you 
clicked on, so the contents of this 
dialog will be different if you clicked 
on something else. 

You can see that the dialog has two 
columns, the column highlighted in 
Figure 2 shows the current 
properties of the object you clicked 
on – down the bottom you can see 
that the net name Text is currently 
VCC. 

 
Figure 2. Properties of the current object loaded into the Find Similar 
Objects dialog 

The second column in the Find 
Similar Objects dialog is where you 
instruct it how to match other 
objects. For each property of the 
object, you can instruct it to match 
target objects when this property 
value is the Same, match when the 
target has a Different value, or set it 
to Any when you are not interested 
in matching by this property. 

Note that in Figure 3, the matching 
will occur when the Object Kind is 
the Same, and when the net name 
Text is the Same. Or to say that 
another way, match when the 
object is a Power Object with a net 
name of VCC. 

 

 
Figure 3. Which properties should be used to match by? 
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The next step is to set the scope of 
the Find action, should it be on the 
Current Document only, or all Open 
Documents. In Figure 4, you can 
see that this has been set to Open 
Documents. For this editing action 
to apply to all the sheets in the 
project, they must be opened first. 

 
Figure 4. What documents should this edit apply to? 

The final step is to define what 
should happen after it has found all 
the Power Objects that have net 
name Text of VCC, in all Open 
Documents.  

Figure 5 shows the important 
settings for this edit operation. The 
highlighted options are Select 
Matching (to select all the VCC 
power ports), and Run Inspector, 
which will open the Inspector panel 
with the selected objects loaded 
into it.  
Click the OK button to select the 
matching Power Ports.  

The Apply button will also select the 
matching power ports and open the 
Inspector, but the Find Similar 
Objects dialog will remain open too 
– use this if you are not sure you 
have your matching criteria correct. Figure 5. What should be done with the found objects? 

TU0115 (v2.2) November 29, 2005 3 



Editing Multiple Objects 

Inspecting the objects Inspecting the objects 
Both the schematic and PCB editors include a 
panel called the Inspector. The basic behavior of 
the Inspector is that it lists the properties of all 
objects that are currently selected. The set of 
selected objects could be the same kind of object, 
for example Figure 6 shows the properties of ten 
power ports.  

Properties that are identical for all the selected 
objects have their value displayed, for example all 
ten power ports currently have an Orientation of 90 
degrees.  

For each power port property that has a different 
value, you will see <…> instead (e.g., the X1 
location). This means that not all these ten objects 
have the same X1 value, which makes sense since 
they each have a different location. 

Note in Figure 6 that the Inspector includes two 
options at the top. It is important that you set the 
second of these, which sets the display of where 
the found objects are from – from the current 
document, open documents, or open documents of 
the same project. To have all the selected power ports loaded into the Inspector, you will need to set 
this to open documents or open documents of the same project. 

 
Figure 6. The Inspector shows the properties of the 
selected objects 

 

The Inspector is a panel that displays the properties of whatever is currently selected. This could be one object, or many 
objects. If more than one object is selected, only properties that are common to all selected objects will be listed. Common 
properties that have the same value will show that value, otherwise the value will display <…>. When you type a value into the 
Inspector and press Enter on the keyboard, the value of that property is immediately changed for all selected objects. 

The Inspector has certain characteristics that make it very handy for everyday use.  

The first is that because it is a panel, it can be visible all the time so you do not need to double-click to open a dialog. This 
means that you can click to select any object in the workspace and its properties will be displayed immediately. This can be 
much more efficient if you are reviewing settings in your design. For example, you might want to check the designator text 
height of a few components on the PCB. If the Inspector is open, you simply click on a designator, read the value, click on the 
next one, read the value, and so on. This would be much faster than double-clicking on one designator, reading the height, 
closing the dialog, double-clicking on the next designator, and so on.  

The second advantage of the Inspector is that it can display the common properties of different objects, and let you edit them. 
We’ll see how this can be useful later in the tutorial.  

Note that at the bottom of the Inspector the total number of selected objects is displayed, always check this and confirm that it is 
what you expect. 

What is the Inspector? 
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Editing the objects 
OK, so far you have selected the objects you want to 
edit, inspected the properties in the Inspector, so now 
you are ready to edit them. 

When you click to edit the net name Text, a pair of 
curly braces appear. These are needed when you 
want to perform a partial string substitution. For this 
edit, we will be replacing all the text, so we simply 
replace the entire contents of the cell with the new text, 
3V3. 

The change you make to the Text value is applied to 
all the selected objects as soon as you press Enter on 
the keyboard, or cl. T on another cell in the Inspector.  
If you change your mind during the edit, press the Esc 
key on the keyboard to abort the edit. To Undo an edit 
that has been applied, select Edit » Undo from the 
menus. If the edit has been applied to multiple 
schematic sheets, you will need to perform an Undo 
action in each sheet. 

 

 
Figure 7. Editing the net name Text 

 

Figure 8 shows the Inspector after 
changing the text and pressing 
Enter, next to one of the edited 
power ports. 

You can use this approach to 
apply an edit globally to any type 
of object in the Schematic or PCB 
editors. 

After performing the edit, you will 
probably find that all the other 
objects on the schematic are 
faded out, or masked. While 
something is masked it cannot be 
edited, to remove the mask click 
the  button at the bottom 
right of the workspace (shortcut, 
Shift+C).  

Figure 8. One of the ten updated power ports 
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Editing group objects Editing group objects 
The edit that we just performed was on a primitive object, that is, one of the basic objects used in the 
Schematic editor. More complex objects such as components are called group objects; these are 
essentially a collection of primitive objects. For example, a component on a schematic is a collection of 
drawing objects, strings, parameters, pins, and references to models. The primitive objects that belong 
to a group object are sometimes referred to as the child objects, and the group object is their parent 
object. 

Let’s look at an example of a typical group object edit that you might want to perform. Your design 
includes a number of 100uF 16V capacitors, using the footprint CAPPR2-5x6.8. Currently the voltage is 
specified as part of the components’ comment string. You need to change this and specify the voltage 
as a parameter of the component instead, and make this parameter visible on the schematic.  

The steps we need to perform are: 
1. Select capacitors, that have a value of 100uF 

16V, and a footprint of CAPPR2-5x6.8. 

Change 2. their comment to be 100uF (remove 

3. ameter to these components, 

4. 

Wh ts to 

Step 1. Selecting the capacitors 
 

 

 approach covered in the previous 
 

e can also match on components that 

. 

Figure 9. Finding the 100uF 16V capacitors 

the 16V text). 

Add a new par
with a name of Voltage, and a Value of 16V. 

Change the visibility of this parameter so the 
voltage is displayed on the schematic. 

ile this might seem a complex set of edi
perform in one go, it is actually quite 
straightforward.  

Firstly, to select all the capacitors, right-click on
the component symbol of one of the 100uF 16V 
caps, and choose Find Similar Objects from the
menu. 

We use the
example, except this time you want to match on
components that have the same Part Comment, 
and the same Current Footprint, as shown in 
Figure 9.  

Note that w
have a designator starting with the letter C. This 
is done by changing the component designator 
value in the Find Similar Objects dialog from 
what it opened as, to C*, as shown in Figure 9

Click the OK button to select the matching 
capacitors. 
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Step 2. Changing the Comment string 
tor will open. Behind it will be the schematic 
heet. If the Zoom Matching and Mask 

nd 

After running the Find Similar Objects dialog, the Inspec
sheet displaying the matching objects selected on that s
Matching options were enabled in the Find Similar Objects dialog, then the view would be zoomed a
all the objects that did not match would be faded, or masked out. 

 

 

Figure 10. The view after performing a Find Similar Objects, showing the matching three capacitors found on this 
sheet. 

 10 shows the results. There are three 
capacitors found on this page, and from the 

 
 the string, and press Enter to 

 

Figure

status line of the Inspector, we can see that 
there is a fourth capacitor found on another 
document. 

To change the comment string, simply delete
the  from16V
apply the change, as shown in Figure 11. 

Figure 11. The capacitor value has been changed 
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Step 3. Adding a new Parameter to the component 
 

The next change that we need to 
make is to add a new parameter to 
these four components, called 
Voltage, and set the value to 16V. To 
do this, we use the Add User 
Parameter feature at the bottom of 
the Inspector. Note that we will enter 
the value first, then the parameter 
name.  

1.   Firstly, type in the value of the 
new parameter, 16V, into the Add 
User Parameter field in the 
Inspector. 

2.   Press Enter to apply the change. 
When you do, the Add new 
parameter to XX objects dialog 
will appear. 

3.   Type in the new parameter name 
and click the OK button. 

 

 
 

 

The Inspector panel will now include the new 
Voltage parameter in the list at the bottom, with 
a value of 16V. You can add as many 
parameters as you wish using this approach. 
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Step 4. Setting the Voltage parameter to be visible 
 

The last step is to make the new Voltage 
parameter visible on these four capacitors. The 
visibility of a parameter is a property of the 
parameter itself, not the component, so we 
cannot change this in the Inspector yet because 
it is displaying the properties of the parent 
components. 

To access the properties of the child parameters, 
click on the hyperlinked Parameter name, 
Voltage, in the Parameters list at the bottom of 
the Inspector. When you do, the Voltage 
parameter properties for the selected 
components will be loaded into the Inspector, 
ready to edit. You can confirm this by checking 
the Object Kind at the top of the Inspector – it 
should say ‘Parameter’. 

Now we can make the Voltage parameter visible 
on the schematic.To do this’ uncheck the Hide 
checkbox, as shown in Figure 12.  

 
Figure 12. Change the visibility of the new parameter 

If you wanted to return to the parent components, 
perhaps to edit some other property, you would 
do this by clicking on the Owner hyperlink, as 
shown in Figure 13. 

We have now updated the comment string for all 
100uF capacitors, using a CAPPR2-5x6.8 
footprint. We have also added a new parameter 
called Voltage, set its value to 16V, and made 
this parameter visible. 

 

 
Figure 13. Returning to the parent component properties 
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Applying an edit to different types of objects globally Applying an edit to different types of objects globally 
Not only can the Inspector panel be used to edit multiple instances of the same object, it can also be 
used to edit common properties of different objects.  

Changing the net name for existing routing 
For the first example, let’s assume that you have made 
design changes on the schematic, removing a pin from 
one net and adding it to another. If the nets were already 
routed on the PCB, then when you update the PCB, you 
could end up with routing that has the wrong net name. 
This routing could include tracks and vias, as well as other 
kinds of objects. 

There are a few ways this could be resolved. The easiest 
is to use the Inspector. Let’s go through the process now. 

1. In the PCB, you would select all the primitives in the 
routed net that needs its name changed, using the 
Edit » Select » Connected Copper command 
(shortcut, Ctrl+H).  

2. If it is not already visible, you would then display the 
Inspector (shortcut, F11). 

3. The Inspector will only show properties that are common to all the selected objects. If you selection 
was correct, one of these will be the Net name. To change this, simply select the new net name 
from the drop down list and press Enter to apply the change. The net property of all the different 
objects in the routed net will be changed. 

Changing the layer property of different objects 

 
Figure 14. Changing the net name of selected 
tracks and vias 

 
Figure 15. Changing the layer for selected 
objects 

Another example might be that you need to move all the 
objects that are on one mechanical layer to another 
mechanical layer. To do this, you would: 
1. Click the Layer tab for the current mechanical layer at 

the bottom of the PCB editor window to make it the 
active layer. 

2. Select all the objects on that layer using the Select » 
All on Layer command (shortcut, S, Y). 

3. If it is not already visible, display the Inspector 
(shortcut, F11). 

4. Select the new Layer name in the drop down list, and 
press Enter to apply the change.  
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Editing multiple parameters using the Parameter Manager 
User-defined design attributes are added to your design using parameters. Component parameters can 
be used to define anything from component ratings, to stock information, to PCB component class 
membership. You can even include links to component datasheets as a parameter. Parameters can be 
added to nets to specify PCB design requirements, or to include the net in a PCB net class. Document 
parameters can be used to define things like the title of the sheet, the designer’s name, and so on.   

Parameters can be added and edited individually, or you can use the Parameter Table Editor to add 
and edit them across the entire design, or across an entire library. When you open the editor, it gathers 
all parameter data for the entire design and presents it in a table-like editing grid. The Parameter Table 
Editor is launched by selecting Parameter Manager from the Tools menu. 

After selecting Parameter Manager from the menus, the Parameter Editor Options dialog appears first. 
In this, you determine which type of parameters you want loaded into the Parameter Table Editor. 

 
Figure 16. Choose which types of parameters that you want to edit 

If you were working on component parameters you would disable all check boxes in the Include 
Parameters Owned By section, except for the Parts check box. If you wanted to work on document 
parameters, you would only enable the Documents check box. Note the Exclude System 
Parameters check box. System parameters include things like component model settings, document 
parameters that were defined in the template, and so on. Explore this option when you are more 
familiar with managing parameters.  
Let’s do some parameter editing now. The following descriptions and images are based on the 4 
Port Serial Interface reference design example. After selecting Tools » Parameter Manager, 
configure the Parameter Editor Options dialog as shown in Figure 16. 
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Renaming a parameter Renaming a parameter 
In Figure 17 below, you will notice that one of the existing parameters is called ‘Text Field1’. This 
needs to be renamed. ‘Component Type’ would be a more suitable name.  
In Figure 17 below, you will notice that one of the existing parameters is called ‘Text Field1’. This 
needs to be renamed. ‘Component Type’ would be a more suitable name.  

Figure 17. Using the Parameter Table Editor to rename an existing parameter Figure 17. Using the Parameter Table Editor to rename an existing parameter 

To rename a parameter, right-click in any cell in that column and in 
the Context menu that appears, select Rename. The Rename 
dialog will open, so type in the new name and click OK. Note that 
the column heading will have changed and now has a small blue 
triangle next to the name (as shown in Figure 18). This icon 
indicates that the value of this cell has changed. For complete 
details on the various icons used in this editor, press F1 when the 
cursor is anywhere over the dialog. 

To rename a parameter, right-click in any cell in that column and in 
the Context menu that appears, select 

Figure 18. The renamed parameter 

Rename. The Rename 
dialog will open, so type in the new name and click OK. Note that 
the column heading will have changed and now has a small blue 
triangle next to the name (as shown in Figure 18). This icon 
indicates that the value of this cell has changed. For complete 
details on the various icons used in this editor, press F1 when the 
cursor is anywhere over the dialog. 

You will also notice in Figure 17 that some of the components do 
not have a Component Type parameter at all –  this is indicated by 
the diagonal hatching. The next step is to add the Component Type 
parameter to all the other components. 

You will also notice in Figure 17 that some of the components do 
not have a Component Type parameter at all –  this is indicated by 
the diagonal hatching. The next step is to add the Component Type 
parameter to all the other components. 
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Adding a parameter 
To add a parameter to components that do not currently have it, select those cells in the editor using 
the Shift+click or Ctrl+click key combinations. Then right-click and choose Add from the context 
menu. 

           
Figure 19. Adding this parameter to the selected components, before adding on the left, and after shown on the right 

After selecting Add, you will notice that a small green plus symbol appears in each cell. This indicates 
that a new parameter has been added.  

Now that the parameter has been added, you can define the component type for each component. The 
Parameter Table Editor supports standard table editing shortcuts. Use the cursor keys to ‘walk’ around 
the grid, press F2 to edit a cell, and press Enter to apply the edit. Multiple cells can be edited in one go 
– select the cells, right click on the selection and choose Edit from the context menu, type in the new 
value, and press Enter to apply the edit to all selected cells. 

                   
Figure 20. Select the cells, right click and Edit (left), type in new value (center) and press Enter (right) 
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Applying the parameter changes 
The parameter edits that have just been carried out are currently held in the Parameter Table Editor 
and they have not been applied to the components on the schematic sheets yet. To apply these 
changes to the components, you need to generate an ECO (Engineering Change Order) and then 
apply the ECO to the design. 
When you are satisfied with your parameter edits, click the Accept Changes (Create ECO) button. 
The Parameter Editor Table will close and the Engineering Change Order dialog will appear.  

 
Figure 21. System applied changes are always done through the Engineering Change Order dialog 

Click the Validate Changes button to check that the changes can be applied, then click Execute 
Changes to apply the parameter changes to the components. Once the changes have been applied, 
close the Engineering Change Order dialog. 
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Managing multiple component models 
The schematic symbol represents the component on the schematic. The wiring then connects the 
component pins to create the connectivity. While this creates the schema, or the inter-connective 
structure of the design, other information is required to translate that into the final physical PCB.  

The ability to translate the original schema into other forms, such as a PCB layout, or perhaps a circuit 
simulation description, is provided by the models that you attach to each component.  

Different model kinds are supported, including PCB footprints, spice simulation models, signal integrity 
analysis models, and 3D models. While these can be defined on the schematic sheet, they are typically 
defined in the component library. For an individual component, it is straightforward to add a model to a 
component. You can add them in the model editing region at the bottom of the main schematic library 
editing window, as shown in Figure 22. 

 
Figure 22. The Schematic Library editor, with the model editing region displayed at the bottom of the main window 

For more information on creating library components and attaching models, refer to the Creating 
Library Components tutorial. 

For a better understanding of component models, refer to the Component, Model and Library 
Concepts article. 
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To add or edit model settings across multiple components, the Library editor includes a Model 
Manager.  To open the Model Manager for the current library, select Tools » Model Manager from the 
menus. The Model Manager dialog will open, displaying the components in the current library down the 
left, click to select a component and display a list of the models currently associated with that 
component.  

To add or edit model settings across multiple components, the Library editor includes a Model 
Manager.  To open the Model Manager for the current library, select Tools » Model Manager from the 
menus. The Model Manager dialog will open, displaying the components in the current library down the 
left, click to select a component and display a list of the models currently associated with that 
component.  

 
Figure 23. Use the Model Manager to manage the models across multiple components 

The tasks that you can perform in the Model Manager include: 

• Add a new model to one or more components 

• Copy a model from one component, and paste it to one or more components 

• Remove a model from one or more components 

• Edit the model assigned to one or more components. 

All of these commands can be executed from the right click context menu in the model list region of the 
dialog and some can also be performed using the buttons below the model list region. 

Figure 23 shows the Model Manager with a PCB footprint model selected and about to be copied. 
Once it has been copied, it can be pasted to multiple components. To do this, use Shift+Click or 
Ctrl+Click to select multiple components in the list. Once the required components are selected, right-
click in the Model region and choose Paste from the context menu. 

An important point to remember when you select multiple components is that only the models that 
are common to all the selected component will be shown. So when you go to paste a footprint 
model to multiple components, don’t be surprised if the model list region is blank. As soon as you 
change to only have one component selected, the current models will appear in the list. 
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Managing footprints across the entire design 
Altium Designer’s schematic editor now includes a powerful Footprint Manager. Launched from the 
PCB Editor’s Tools menu, the Footprint Manager lets you review all the footprints associated with 
every component in the entire project. Multi-select support makes it easy to edit the footprint 
assignment for multiple components, change how the footprint is linked, or change the Current footprint 
assignment for components that have multiple footprints assigned. Design changes are applied 
through Altium Designer’s standard ECO system, updating both the schematic and the PCB if required. 

 
Figure 24. Use the footprint manager to review and manage the footprints across the entire PCB. 

Using a query to find and edit multiple objects 
Altium Designer has a powerful query engine built into it, which is used to precisely target design 
objects. A query is essentially a description of something that you would like to find in the design data.  

Filtering to find the objects 
You can query the design data in a number of different ways. One of these is to type the query in to the 
Filter panel. When you apply the query you are filtering the design database. Each object is tested to 
see if complies with the query, and if it does, it is added to the result set.  
Figure 25 shows the Schematic Library editor Filter panel, with the query IsPin typed in. When this 
query is applied, every object in the Whole Library is checked (since the Whole Library option is 
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enabled), any object that is a pin will comply and be added to the result set. All other objects are 
filtered out.  
enabled), any object that is a pin will comply and be added to the result set. All other objects are 
filtered out.  

 
Figure 25. Using the Filter panel to query for Pins in the entire library 

How the results are presented depends on the options on the right of the Filter panel. In Figure 25, you 
can see that objects that pass the filter (pins in this case) will be selected and zoomed. All other objects 
that do not pass the filter will be de-selected and masked out (faded and made non-editable). 
Since the Select option is enabled, the pins will loaded into the Inspector. The Inspector essentially 
‘stacks’ the selected objects to give one view into their common properties, which is not that useful for 
editing component pins (unless perhaps you wanted to change their length).  

The pins will also be displayed in the List panel, which presents design data in a tabular grid, where it 
is easy to compare and edit one or more objects at once. 

When you apply a Filter with the Mask out option enabled, the objects that are filtered out will 
become faded and non-editable. To remove this filter, click the  button at the bottom right 
of the workspace (shortcut, Shift+C). 

Editing design objects in the List panel 

 
Figure 26. Pins of the current component, presented in the List panel 

Figure 25 shows the Schematic Library editor List panel loaded with pins. Note that the from option at 
the top of the panel is currently set to current component, even though the filter was configured to 
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select them for the whole library. There are scope controls in both the Filter panel and the List panel; 
this is because you control filtering separately from result display. You can use this to do things like find 
all pins in the current library, then switch between looking at all the pins, or just those in the current 
component. 

The tabular grid of the List panel is ideal for reviewing and editing objects. Once you have set the List 
to be in Edit mode (the option at the top left of the panel), you can use keys on the keyboard to ‘walk’ 
around and edit settings. For example, use the arrow keys to move around the grid, F2 or Spacebar to 
edit the selected cell, Enter to apply a change, Spacebar to toggle a checkbox if that cell is active, and 
so on. 

The List panel is completely configurable. To add or remove columns, or to change the order of 
columns, right-click on the column headings and select Choose Columns from the context menu. 

Using your spreadsheet editor to edit design data 
Not only can you edit data directly in the List panel, you can also multi-select blocks of cells and copy 
them from the List into your preferred spreadsheet editor, and from the spreadsheet back into the List. 
For example, you are creating a new component and you have copied all the pin data from the 
manufacturer’s PDF datasheet into a spreadsheet. Rather than entering this data into the Schematic 
Library editor one pin at a time, you can: 
1. Place one pin in the new schematic component, copy it, then use Paste Array to give you the total 

number of pins required. 
2. Use the query IsPin in the Filter panel to load these pins into the List panel. 

3. Set up the relevant pin data columns, so that they correspond to the arrangement of columns in the 
spreadsheet editor. 

4. Switch to the spreadsheet editor, select the required block of pin data and copy it. 
5. Switch back to the List panel, select the same block of cells, right-click and choose Paste from the 

context menu 

You might want to copy a block of data from the List to the spreadsheet first, to see how the data is 
represented in the spreadsheet. Using this approach, you can quickly configure a large number of 
component pins in your new component. The following figures illustrate this sequence: 

 
Figure 27. Pin data in the spreadsheet editor, as it is copied onto the clipboard 
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Figure 28. Select the target block of cells in the List panel, right-click and choose Paste 

 
Figure 29. The List panel after the pin data has been pasted in 
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Filtering objects in the design workspace – how does it work? 

Display dataFiltering Engine

Filter
panel

Navigator
panel

FSO
dialog

Highlighting Engine
(Mask, Select, Zoom)

Query Engine

Design data

 

Figure 30. Diagram of the filtering/highlighting process 

Figure 30 shows how design data is filtered and highlighted. Note how you can control the filtering 
process by writing a Query in the Filter panel, by configuring options in the Find Similar Objects (FSO) 
dialog (which actually uses a query behind the scenes), or by selecting objects in the Navigator panel. 
The PCB panel is not shown however, like the Navigator, it can also filter data in the PCB workspace.  

The Highlighting engine determines how the filtered data will be presented. 

As the user, you can access the filtered Display data in the main graphical editing window, in the 
Inspector (if you instructed the highlight engine to select it), or in the List panel. 

Tips for writing queries 
• Use the Query Helper to become familiar with the available query keywords. Press the Helper 

button in the Filter panel to display the helper. 
• Press F1 over a keyword to display on-line help for that query keyword. 

• Use the Mask field at the bottom of the Query Helper dialog to search for possible keywords. If 
you include the * wildcard character at the start of the string you are looking for, you will find all 
references to that text string in the keywords and also in the descriptions. 

• Click the Check Syntax button before you close the Query Helper dialog. 
• Include quotation marks around a variable, for example ‘DIP14’. 

• There is an order of precedence used to resolve queries, so include brackets to be sure that it is 
resolved in the correct sequence. 

For an overview of the query system read the Introduction to the Query Language, for detailed 
information on writing queries refer to the article, An Insiders Guide to the Query Language. 

 

TU0115 (v2.2) November 29, 2005 21 



Editing Multiple Objects 

Revision History 
 

Date Version No. Revision

9-Dec-2003 1.0 New product release 

1-Dec-2004 2.0 Rewritten to suit updated Inspector, List and Filter panels 

13-Apr-2005 2.1 Updated for Altium Designer Service Pack 4 

29-Nov-2005 2.2 Reviewed and updated for Altium Designer 6 
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without the express written permission of Altium Limited. Unauthorized duplication of this work may also be 
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Nexar, nVisage, P-CAD, Protel, CircuitStudio, Situs, TASKING, and Topological Autorouting and their respective 
logos are trademarks or registered trademarks of Altium Limited or its subsidiaries. All other registered or 
unregistered trademarks referenced herein are the property of their respective owners and no trademark rights to 
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